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Executive summary

Intel Corporation (Intel) commissioned Principled
Technologies (PT) to compare the performance on Microsoft
Windows Vista of an Intel vPro technology based PC with
that of three other platforms on common predictive modeling
and business intelligence scenarios. We tested two
scenarios that involve Microsoft Office Excel 2007 and a
third that uses Intuit QuickBooks Pro 2006. We compared
the performance of the following four platforms on these
scenarios:

e Intel Core 2 Duo processor E6700 on an Intel vPro
965 (DQY65GF) motherboard

e Intel Pentium D processor 930 on an Intel D945GTP
motherboard

e Intel Pentium 4 processor 630 on an Intel D945GTP
motherboard

e Intel Pentium 4 processor 2.8 GHz on an Intel
D865GBF motherboard

As Figure 1 shows, the Intel vPro technology based PC with
the Intel Core 2 Duo processor E6700 significantly

KEY FINDINGS

The Intel® vPro™ technology based PC
featuring the Intel® Core™ 2 Duo processor
E6700 yielded significant performance
advantages for users on our sample
predictive modeling and business
intelligence tests.

The Intel vPro technology based PC with the
Intel Core 2 Duo processor E6700 finished
our three test tasks on average 2.53 times
faster than the Intel® Pentium® D processor
930 based PC.

The Intel vPro technology based PC with the
Intel Core 2 Duo processor E6700 also
finished our tasks on average 3.34 times
faster than the Intel® Pentium® 4 processor
2.8GHz based PC.

These performance improvements translate
into multi-second time savings that would be
noticeable to users.

outperformed the other PCs in all three scenarios. The Intel vPro technology based PC with the Intel Core 2 Duo
processor E6700 was from 1.91 times to 3.12 times faster on different tasks than the Intel Pentium D processor
930 based PC and averaged 2.53 times faster across all the tasks. (In all comparisons in which we cite the
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Figure 1: Normalized results for the test systems on all three scenarios. Larger numbers indicate

better performance.




For example, the longest task took 77.34 seconds on the Intel Pentium D processor 930 based PC but only 28.55
seconds--almost 49 seconds faster--on the Intel vPro technology based PC with the Intel Core 2 Duo processor
E6700.

So that we could make the test systems as similar as reasonably possible while varying the processors and
motherboards, we built the systems rather than purchasing them from vendors. Intel specified the general system
types. We purchased the processors and motherboards as well as such common components as RAM, hard
disks, and optical drives. Each test system had the following basic components (see Appendix A for detailed
configuration information):

1GB of the fastest RAM its motherboard supported

80GB hard disk with an 8MB buffer (SATA unless the motherboard did not support it)
DVD-RW optical drive

Microsoft Windows Vista Ultimate

We used the following common business intelligence based applications, which we list in alphabetical order:

e Intuit QuickBooks Pro 2006
e Microsoft Office Excel 2007

The application scenarios we tested included such common functions as:

e Opening files
e Recalculating Excel spreadsheets

In the following sections we look more closely at our test application scenarios (Application scenarios), examine
the results of our tests (Test results and analysis), and give detailed information about how we actually performed
the tests (Test methodology). In the appendices, we present the configurations of the test systems and explain
how to manually execute the application functions in our scenarios.

Application scenarios

We chose scenarios that involve common predictive modeling and business intelligence tasks and applications. In
two of our scenarios we used Microsoft Office Excel 2007. The multithreaded design of this new version of Excel
paid dividends in user performance on the Intel vPro technology based system. The third scenario uses Intuit
QuickBooks Pro 2006, an application common in small and medium businesses.

Recalculating business revenue using Microsoft Office Excel 2007

Brian Corcoran is a forensic accountant investigating a failed business that is the plaintiff in a shareholder class-
action suit. He is examining the original spreadsheet the business used to estimate revenues over five years of its
telecommunications services. The spreadsheet calculates revenues based on the number of T1 trunks and
customers and the penetration of voice, call management, and multimedia services. Brian recalculates the Excel
spreadsheet to see how the various models it employs compare to the actual revenues of the company.

We timed:

e the Microsoft Excel 2007 calculation from when Brian presses F9 in Excel to start the recalculation
until the recalculation percentage indicator reached 100 percent and closed

Running a Monte Carlo simulation in Microsoft Office Excel 2007

Jordan Michaels, a GMC auto dealer, believes that demand for new Envoys will be normally distributed with a
mean of 200 and standard deviation of 30. His cost of receiving an Envoy is $25,000, and he sells an Envoy for
$40,000. He can sell half of all the leftover Envoys for $30,000. He is trying to decide how many Envoys to order,
so he builds a spreadsheet with models of orders of 200, 220, 240, 260, 280, and 300 Envoys. Jordan is able to
calculate the number of Envoys he should order for his dealership by using a Monte Carlo simulation that runs on
Microsoft Office Excel 2007.
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To take advantage of publicly available data, we started with a Monte Carlo spreadsheet from Microsoft's Web
site. (Adapted from Winston, W.L. (2004): Microsoft® Excel®: Data Analysis and Business Modeling. Washington:
Microsoft Press, p. 462.) To make this initial spreadsheet more like one a real business might use, we added
additional worksheets for each quantity of vehicles--200, 220, 240, 260, 280, and 300--that the dealer is
considering purchasing.

We timed:

e the Microsoft Excel 2007 calculation from when Jordan presses F9 in Excel to start the recalculation
until the Data Table indicator on the Status Bar goes away

Viewing a set of memorized reports in Intuit QuickBooks Pro 2006

Mark Owens is in charge of examining the books of a company, Rock Castle Construction, that his firm is
interested in acquiring. He instructs his accountant to go through Rock Castle Construction’s Intuit QuickBooks
data file and prepare multiple memorized reports for him to review. When Mark receives the QuickBooks file from
his accountant, he loads the file onto his system. He then opens the set of memorized reports to view Rock
Castle’s overall performance since its inception.

We timed:

e the appearance of the Intuit QuickBooks Pro 2006 reports from when Mark clicks Display until all the
report windows are open

For more details on how we executed and measured these scenarios, our specific test functions, and the files the
scenarios use, see Appendix B.

Test results and analysis

In this section we examine the results of each of our tests. Figure 2 shows the times, in seconds, that each test
system needed to complete each scenario. The times we show for each platform for each scenario are from the
median run of the five test runs of that scenario on that platform.

Intel Intel vPro
Pentium 4 Intel Intel with Core 2
Pentium 4 Pentium D [Duo

processor

Tests 28 GHzon |Processor processor [processor
Ir.ntel 630 on Intel |[930 on Intel [E6700 on
D865GBF D945GTP D945GTP Intel

DQ965GF

Excel recalculation scenario

Recalculating business revenue using Microsoft Excel 2007 | 133.56 [ 116.10 | 77.34 | 28.55

Monte Carlo simulation

Running a Monte Carlo simulation in Microsoft Excel 2007 | 14.92 | 14.60 | 14.46 | 4.63

Intuit QuickBooks scenario

Viewing a set of reports in Intuit QuickBooks Pro 2006 [ 10.26 | 10.11 | 7.94 | 4.15

Figure 2: Median test times, in seconds, for all test systems on all three scenarios. Lower numbers are better.

In the following sub-sections we explore these results in more detail. To make comparisons easier, we always
show results normalized to those of the slowest system in the group, the Intel Pentium 4 processor 2.8GHz based
PC with the Intel D865GBF motherboard. To compute those normalized results, we divided each system’s time by
the time it took the slowest system. The result for the Intel Pentium 4 processor 2.8GHz based PC with the Intel
D865GBF motherboard is thus always 1.00, because it's the comparison basis. Results higher than 1.00 indicate
how much faster a system is than that system. Because of the normalization, higher result numbers are better.
For example, a result of 1.80 would mean the system in question was 80 percent faster than the Intel Pentium 4
processor 2.8GHz based PC.
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Recalculating business revenue using Microsoft Office Excel 2007
As Figures 3 and 4 show, the Intel vPro technology based PC with the Intel Core 2 Duo processor E6700 was
2.71 times faster than the Intel Pentium D processor 930 based PC on this test. Additionally, the Intel vPro
technology based PC with the Intel Core 2 Duo processor E6700 was 4.68 times faster than the PC with the Intel
Pentium 4 processor 2.8GHz and the Intel D865GBF motherboard.
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Excel recalculation scenario

Recalculating business revenue using

Microsoft Office Excel 2007
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Figure 3: Normalized results for the Excel recalculation scenario for all test systems. Larger
numbers indicate better performance.

As Figure 4 shows,
these differences
represent significant
improvements in the
time it takes to
perform each task.
Compared to the Intel
Pentium D processor
930 based PC, the
Intel vPro technology
based PC with the
Intel Core 2 Duo
processor E6700
decreased the
elapsed time from
77.34 to 28.55
seconds. Compared
to the PC with the
Intel Pentium 4
processor 2.8GHz on
the Intel D865GBF
motherboard, the Intel
vPro technology
based PC with the

Intel Core 2 Duo processor E6700 decreased the elapsed time from 133.58 to 28.55 seconds--a savings of over a
hundred seconds.

PERFOR(I\::‘:‘::;E SESULTS COMPARATIVE RATING
Intel Intel Intel In_tel A Intel Intel Intel In_tel e
. . . with Core 2 . . . with Core 2
Pentium 4 |Pentium4 |PentiumD Duo TASKS Pentium 4 (Pentium4 |PentiumD Duo
processor |processor | processor | .. . processor |processor |processor [ .. . .
2.8 GHz on 630 on 930 on 26700 - 2.8 GHz on (630 on 930 on 26700 o
Intel Intel Intel intel Intel Intel Intel intel
D865GBF |D945GTP D945GTP DQIE5GF D865GBF |D945GTP D945GTP DQIE5GF
Task:
133.56 | 116.10 | 77.34 28.55 | Recalcuatng | 400 1.15 1.73 4.68
revenue

Figure 4: Results for the Excel recalculation scenario for all test systems. Lower performance results are better. Higher
comparative ratings are better.
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Running a Monte Carlo simulation in Microsoft Office Excel 2007
Figures 5 and 6 illustrate the results of this test. The Intel vPro technology based PC with the Intel Core 2 Duo
processor E6700 was 3.12 times faster than the Intel Pentium D processor 930 based PC. Additionally, the Intel
vPro technology based PC with the Intel Core 2 Duo processor E6700 was 3.22 times faster than the PC with the
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Figure 5: Normalized results for the Monte Carlo simulation for all test systems. Larger numbers
indicate better performance.

Intel Pentium 4
processor 2.8GHz on
the Intel D865GBF
motherboard.

As Figure 6 shows,
these differences
represent significant
improvements in the
time it takes to perform
each task. Compared to
the Intel Pentium D
processor 930 based
PC, the Intel vPro
technology based PC
with the Intel Core 2
Duo processor E6700
decreased the elapsed
time from 14.46 to 4.63
seconds. Compared to
the PC with the Intel
Pentium 4 processor
2.8GHz on the Intel
D865GBF motherboard,
the Intel vPro
technology based PC

with the Intel Core 2 Duo processor E6700 decreased the elapsed time from 14.92 to 4.63 seconds.

PERFORMANCE RESULTS

COMPARATIVE RATING

(seconds)
Intel Intel Intel In_tel U Intel Intel Intel In_tel A
. . . with Core 2 . . . with Core 2
Pentium 4 |Pentium4 |PentiumD D TASKS Pentium 4 |Pentium 4 |Pentium D
uo Duo
processor |processor |processor | .. . processor |processor |processor brocessor
2.8 GHz on |630 on 930 on P 2.8 GHz on |630 on 930 on
E6700 on E6700 on
Intel Intel Intel intel Intel Intel Intel intel
D865GBF [D945GTP D945GTP DQ9E5GF D865GBF |D945GTP D945GTP DQ965GF
Task: Running a
14.92 14.60 14.46 4.63 Monte Carlo 1.00 1.02 1.03 3.22
simulation
Figure 6: Results for the Monte Carlo simulation for all test systems. Lower performance results are better. Higher
comparative ratings are better.
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Viewing data in Intuit QuickBooks Pro 2006
As Figures 7 and 8 show, the Intel vPro technology based PC with the Intel Core 2 Duo processor E6700 was
1.91 times faster than the Intel Pentium D processor 930 based PC on this test. Additionally, Intel vPro technology
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Viewing memorized reports in
Intuit QuickBooks Pro 2006
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w ith Intel Core 2 Duo processor
E6700

Figure 7: Normalized results for the Intuit QuickBooks scenario for all test systems. Larger
numbers indicate better performance.

based PC with the Intel
Core 2 Duo processor
E6700 was 2.47 times
faster than the PC with
the Intel Pentium 4
processor 2.8GHz on
the Intel D865GBF
motherboard.

Figure 8 shows that
these differences
represent significant
improvements in the
time a user would need
to perform each task.
Compared to the Intel
Pentium D processor
930 based PC, the Intel
vPro technology based
PC with the Intel Core 2
Duo processor E6700
decreased the elapsed
time from 7.94 to 4.15
seconds. Compared to
the PC with the Intel
Pentium 4 processor

630, Intel vPro technology based PC with the Intel Core 2 Duo processor E6700 decreased the elapsed time from
10.11 to 4.15 seconds on the task.

PERFOR("::c'iﬁESESULTS COMPARATIVE RATING

Intel Intel Intel wltt(;l é’::g 2 Intel Intel Intel wittil é':,:z 2

Pentium 4 (Pentium4 |PentiumD Duo TASKS Pentium 4 (Pentium4 |[PentiumD Duo
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intol " linl . [intel . [ESTODon intel " lintel . |intor . [ES7000n
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Task: Viewing
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QuickBooks

Figure 8: Results for the Intuit QuickBooks scenario for all test systems. Lower performance results are better. Higher
comparative ratings are better.
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Test methodology

Setting up the test systems
To get the most accurate and repeatable results possible, start with a clean hard disk and set up all the test
systems using the following procedures.

Installing Microsoft Windows Vista Ultimate
Use the following process to install a clean version of Windows Vista Ultimate on each system under test:

1. Install Windows Vista Ultimate Build 6000.
Boot to a Windows Vista Ultimate Build 6000 DVD.
When prompted, press any key to boot from the DVD.
At the language and preference screen, accept the default options, and click Next.
Click Install now.
Do not enter a Product key. Uncheck Automatically activate Windows when I’'m online, and click Next.
At the Do you want to enter your product key now screen, click No.
Select Windows Vista Ultimate, and check | have selected the edition of Windows that | purchased.
Click Next.
Check | accept the license terms.
Click Next.
At the Which type of installation do you want screen, select Custom (advanced).
Click Drive options (advanced).
. Select the destination Disk for the operating system.
Click Format.
Click OK at the all data stored will be permanently deleted dialog.
Once the system finishes formatting the disk, click Next.
Fill in the Username and Password fields, and click Next.
Fill in the computer name field, and click Next.
When the system presents the option to enable Automatic Updates, click Ask me later.
Select the correct time zone, date, and time, and click Next.
At the Select your computer’s current location screen, click Public location.
Click Start at the Thank you screen.
When the Windows Vista Ultimate installation completes, close the Welcome Center Dialog.
At the Set network location screen, click Public location.
. Click Close.
2. Set the test resolution.
a. Right-click on the desktop.
b. Select Personalize.
c. Click Display Settings.
d. If the monitor resolution is not already 1280 by 1024, adjust it to that setting.

SXE<ECTYPTOTOSIITATTSQ@T0Q0TY

e. Click OK.
3. Verify that Windows Automatic Updates are off.
a. Click Start.

b. Select Control Panel.

c. Click Security.

d. Under Security Center, select Turn automatic updating off.
e. Select the Never check for updates radio button.

f

Click OK.
4. Turn off System Restore. Doing so prevents such events from occurring during testing and affecting
results.
a. Click Start.
b. Right-click Computer.
c. Select Properties.
d. Select System protection on the left.
e. Click Continue.

Principled Technologies, Inc.: System performance in predictive modeling and 7
business intelligence scenarios on Microsoft Windows Vista



f.  Uncheck each box under Automatic restore points.
g. Select Turn System Restore Off at the System Protection pop-up window.
h. Click OK.
5. Add the system to the test domain.
Click Start.
Right-click Computer
Select Properties.
Select Change settings.
Click Continue.
Click Change.
Select the Domain radio button.
Type the test domain name.
Click OK.
Type the administrator credentials in the User name and Password fields.
Click OK.
Click OK at the Computer Name/Domain Changes dialog box.
. Click OK again.
Close the System Properties window.
Close all other open windows before clicking Restart Now.
Log in.
Uncheck the Run at startup box on the Welcome Center before closing it.
dd the user to the Administrators group.
Click Start.
Right-click Computer.
Select Manage.
Click Continue.
Select Local Users and Groups on the left.
Double-click Groups in the center.
Select Administrators.
Click Add..., and type the domain test user account.
Click OK.
Type the administrator credentials in the User name and Password fields.
Click Apply.
Click OK.
Close all windows.
Click Start.
Click the arrow->.
Select Log Off.
Press Ctrl + Alt + Delete at the prompt.
Click Switch User, and select Other User.
Type the test user’s credential in the User name and Password fields.
Press Enter.
urn all Power Management settings to Performance.
Click Start.
Select Control Panel.
Select Appearance and Personalization.
Under Personalization, click Change screen saver.
Select (None) from the Screen saver drop-down menu.
Click the Change power settings link.
Click the High performance radio button.
Select Never for the Turn off the display and Put the computer to sleep drop-down menus.
Click Change advanced power settings.
Click Hard disk->Turn off hard disk after>Setting (Minutes), then type Never.
Scroll down, and click Sleep->Sleep after-> Setting (Minutes), and type Never.
Click Sleep—>Allow Hybrid Sleep-> Setting.
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Select Off.

Scroll down, and click Display-> Turn off display after-> Setting, then type Never.
Click OK.

Click Save changes.

Close the Power Options window.

Click OK on the Screen Saver Settings.

Installing Adobe Flash Player 9.0
Use the following process to install a clean version of Adobe Flash Player 9:

TLT OS5 3

1. Install Adobe Flash Player 9 from
http://www.adobe.com/shockwave/download/download.cgi?P1_Prod Version=ShockwaveFlash&promoid
=BIOW.
a. Uncheck the box next to YAHOO! toolbar, and click Install Now.
b. Click Continue at the User Account Control dialog.
c. Click Install at the Security Warning dialog.
d. Flash Player is successfully installed when the flash installation completion movie plays.

Installing Intuit QuickBooks Pro 2006
Use the following process to install a clean version of Intuit QuickBooks Pro 2006. This installation includes an
automatic installation of the Microsoft .NET 1.1 Runtime.

Note: We occasionally received the following message near the end of the Intuit QuickBooks install: “Error
1904.Module C:\QB.ocx failed to register”. We clicked Ignore to bypass this error.

1. Insert the Intuit QuickBooks Pro 2006 installation CD.

Click Run setup.exe.

Click Allow at the User Account Control screen.

Click Run program at the Program Compatibility Assistant screen.

Click Install at the welcome screen.

Click Next at the .NET 1.1 Runtime installation screen.

Click Next at the Welcome to QuickBooks Installation Wizard screen.

Select Accept, and click Next at the License Agreement screen.

Enter the Intuit QuickBooks License Number and Product Number, and click Next.

Accept the default installation path, and click Next.

Click Install at the Ready to install QuickBooks screen.

Click Finish at the installation complete screen.

Click OK at the QuickBooks has completed verifying configuration dialog.

2. After installation of Intuit QuickBooks Pro 2006 completes, configure the application for testing by
following these steps once:
a. Launch the application by double-clicking the QuickBooks Pro 2006 desktop shortcut.
b. Click File>Open Company.
c. Select sample_product based_business.gbw, and click Open.
d. Click OK at the QuickBooks Information dialog.

3. Atthe QuickBooks Learning Center screen, uncheck Show this window at startup, and close the
Welcome screen.

4. Turn off automatic updates by following these steps once:

a. Click Help>Update QuickBooks—>Options.

b. Select No to Automatic Update.

c. Click Save.

d. Close the Update dialog.

Close all open windows.

Close QuickBooks.

Launch Intuit QuickBooks Pro 2006.

Verify that a single window with the titte No Company Open appears.

Close QuickBooks.
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Installing Microsoft Office Enterprise 2007
Use the following process to install a clean version of Microsoft Office 2007 Enterprise on both the Windows Vista
and Windows XP operating system images for each system:

Insert the Microsoft Office Enterprise 2007 DVD.

Select Run SETUP.EXE.

Click Continue at the User Account Control dialog.

Click Install Now.

Click Close at the Microsoft Office Enterprise 2007 has been successfully installed screen.

aorON=
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Appendix A — Test system configuration information
This appendix provides detailed configuration information about each of the test systems.

Intel vPro with
Intel Core 2 Duo
processor E6700

Intel Pentium D
processor 930

Intel Pentium 4
processor 630

Intel Pentium 4
processor (2.8

System processorand | (> 66 GHz Dual- (gfrg"c"zn Bual- | (3.0 GHz) on Intel |  GHz) on Intel
Core) on Intel D945GTP D945GTP D865GBF
DQ965GF motherboard motherboard
motherboard
motherboard
General
Processor and OS kernel:
(physical, core, logical) / 1P2C2L / MP 1P2C2L / MP 1P1C2L / MP 1P1C1L/UP
(UP, MP)
Number of physical y 1 1 1
processors
Single/Dual-Core Dual Dual Single Single
processors
Processor HT status NA NA Enabled NA

System Power
Management Policy

High Performance

High Performance

High Performance

High Performance

CPU

Vendor Intel Intel Intel Intel
Name Core 2 Duo Pentium D Pentium 4 Pentium 4
Model Number E6700 930 630 NA
Stepping 6 2 3 7
Socket type LGA775 LGA775 LGA775 Socket 478
Core frequency (GHz) 2.66 3.0 3.0 2.8
Front-side bus frequency | 1066 MHz 800 MHz 800 533 MHz

+

4 MB (2 MB per

BIOS name and version

93.2006.1102.172
8

43.2006.0707.140
5

43.2006.0707.140
5

L2 Cache 4 MB (shared) 2 MB 512 KB
core)
Platform
Vendor Intel Intel Intel Intel
r'\]"uor;hbeerf’oard model DQI65GF D945GTP D945GTP D865GBF
Motherboard chipset Intel Q965 Intel iI945G Intel iI945G Intel i865G
Motherboard revision C1 AD AD A2
number
Motherboard serial BQGF63500GE9/ | LATP61618159/ LATP61618114 / ABBF31715528 /
number AAD41676-305 AAC97837-301 AAC97837-301 AAC28142-401
Intel Intel Intel Intel
C096510J.86A.54 | NT94510J.86A.39 | NT94510J.86A.39 | BF86510A.86A.00

58.P15.04040500
12

BIOS settings Setup default Setup default Setup default Setup default
Memory module(s)

. Micron Micron
Vencéor and model g:(;%alr CM2X512A- SHTFE6464AY- SHTFE6464AY- gglr_%sdfuz%ngrﬁ-CCC
number 667D7 667D7
Type PC2-6400 PC2-5300 PC2-5300 PC3200
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6.0.6000.16384

6.0.6000.16384

Speed (MHz) 800 667 667 400

Speed running in the

system (MHz) 400 333 333 166

Timing/Latency (tCL-

{RCD-tRP-tRASMIn) 5-5-5-18 5-5-5-15 5-5-5-15 2.5-3-3-7

Size 1024 MB 1024 MB 1024 MB 1024 MB

Number of memory 2 x 512 MB 2 x 512 MB 2 x 512 MB 2 x 512 MB

modules

Chip organization Double-sided Double-sided Double-sided Double-sided

Channel Dual Dual Dual Dual

Hard disk

Vendor and model Seagate Seagate Seagate Seagate

number ST3808110AS ST380811AS ST380811AS ST3802110A

Size 80 GB 80 GB 80 GB 80 GB

Buffer Size 8 MB 8 MB 8 MB 2 MB

RPM 7200 7200 7200 7200

Type SATA 300 MB/s SATA 150 MB/s SATA 150 MB/s ATA 100

Controller Intel 82801HR Intel 82801GB Intel 82801GB Intel 82801EB
(ICH8) (ICH7) (ICH7) (ICH5)

Driver Intel 6.2.0.2002 Microsoft Microsoft Microsoft

6.0.6000.16384

Operating system

Microsoft Microsoft Microsoft Microsoft
Name Windows Vista Windows Vista Windows Vista Windows Vista
Ultimate RTM Ultimate RTM Ultimate RTM Ultimate RTM
Build number 6000 6000 6000 6000
File system NTFS NTFS NTFS NTFS
Kernel ACPI x86 based ACPI x86 based ACPI x86 based ACPI x86 based
PC PC PC PC
Language English English English English
Microsoft DirectX version | DirectX 10 DirectX 10 DirectX 10 DirectX 10
Graphics
Vendor and model Intel GMA 3000 | Intel GMA 950 Intel GMA 950 Intel Extreme
number Graphics 2
Type Integrated Integrated Integrated Integrated
: Intel Q965 Intel 945G Intel 945G
Chipset Express Chipset Express Chipset Express Chipset Intel 865G
BIOS version 1377 1256 1256 1318
Memory size 256 MB Shared 128 MB Shared 128 MB Shared 224 MB
Resolution (for single- 1280 x 1024 x 32 1280 x 1024 x 32 1280 x 1024 x 32 1280 x 1024 x 32
monitor tests) @ 60Hz @ 60Hz @ 60Hz @ 60Hz
Driver Intel 7.14.10.1111 | Intel 7.14.10.1111 | Intel 7.14.10.1111 | Intel 6.14.10.4656
Other for dual monitor PixelView ADD- PixelView ADD- PixelView ADD- NA
tests 7307-DVI-N 7307-DVI-N 7307-DVI-N

Sound card/subsystem

Vendor and model

SigmaTel 92XX
High Definition

SigmaTel 92XX
High Definition

SigmaTel 92XX
High Definition

SoundMAX
Integrated Digital

number Audio Audio Audio Audio Device
Driver Microsoft Microsoft Microsoft Analog Devices

6.0.6000.16386 6.0.6000.16384 6.0.6000.16384 5.12.1.5410
Ethernet
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Vendor and model
number

Intel 82566DM
Gigabit

Intel PRO/1000
PM

Intel PRO/1000
PM

Intel PRO/1000
CT

Driver

Intel 9.6.8.0

Microsoft 9.6.8.0

Microsoft 9.6.8.0

Microsoft 8.1.37.2

Optical drive(s)

Vendor and model

Lite-On DVDRW

Lite-On DVDRW

Lite-On DVDRW

Lite-On DVDRW

number SHW-160P6S SHW-160P6S SHW-160P6S SHW-160P6S
Type DVD-RW DVD-RW DVD-RW DVD-RW
Dual/Single layer Dual Dual Dual Dual
USB ports
# of ports 8 6 6 4
Type of ports (USB1.1,
USB2.0) USB 2.0 USB 2.0 USB 2.0 USB 2.0
IEEE 1394 ports
# of ports 1 1 1 [0
Monitor
Samsung Samsung Samsung Samsung
Model SyncMaster SyncMaster SyncMaster SyncMaster
997DF 997DF 997DF 997DF
Screen size 19” 19 19 19”

Figure 9: Detailed system configuration information for each of the test systems.
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Appendix B — Instructions for running the application scenarios
We evaluated the performance of each of the test systems on each of the application scenarios (see the
Application scenarios section for more information on them) by hand-timing the tasks in those scenarios.

We collected results for five runs of each scenario in each system configuration. We refer in this paper only to the
median results of those runs on each system configuration. Lower times to complete a given function indicate
better performance. We round those times to hundredths of seconds in this report.

In the following instructions, we assume you have already completed all of the setup work in the Test
Methodology section.

Recalculating business revenue using Microsoft Office Excel 2007

The application involved
e Microsoft Office Excel 2007

The data file involved
e Excel2ZminA.xls, a 447KB Excel spreadsheet

The test process
First, prepare each system by following these steps once:

1. Copy the Excel2minA.xls test file to the desktop.

2. Launch Microsoft Office Excel 2007 by clicking Start->All Applications—>Microsoft Office>Microsoft Office
Excel 2007.

3. Click the Office Button.

4. Click Excel Options.

5. Click Trust Center.

6. Click Trust Center Settings.

7. Click Macro Settings.

8. Select Enable all macros (not recommended; potentially dangerous code can run).

9. Click OK to close the Trust Center.

10. Click OK to close Excel Options.

To execute the test, follow these instructions. You will need one stopwatch.

Reboot the system under test.

Log in.

Wait 2.5 minutes to be sure the system has completed booting and is in a consistent starting state.
Double-click the Excel2minA.xls file to open it.

Click the Outputs tab to open the Outputs Worksheet.

Wait 10 seconds after opening the file.

Prepare the stopwatch.

Simultaneously press F9 and start the stopwatch.

Stop the stopwatch when the recalculation percentage indicator reaches 100 percent and closes.
10 Record this time as the test’s result.

11. Repeat these steps four times for a total of five runs.

CoNO>ORA~LON =

We report the time, in seconds, that Microsoft Office Excel 2007 took to perform the recalculation. Lower times
indicate faster performance and so are better.

Running a Monte Carlo simulation in Microsoft Office Excel 2007

The application involved
e Microsoft Office Excel 2007

Principled Technologies, Inc.: System performance in predictive modeling and 14
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The data file involved
o AutoDealer.xls, a 1.5MB Excel spreadsheet

The test process
First, prepare each system by following these steps once:

1. Copy AutoDealer.xls to the desktop.
Launch Microsoft Office Excel 2007 by clicking Start->All Applications—>Microsoft Office>Microsoft Office
Excel 2007.

3. Click the Office Button.

4. Click Excel Options.

5. Click Trust Center.

6. Click Trust Center Settings.

7. Click Macro Settings.

8. Select Enable all macros (not recommended; potentially dangerous code can run).

9. Click OK to close the Trust Center.

10. Click OK to close Excel Options.

To execute the test, follow these instructions. You will need one stopwatch.

1. Reboot the system under test.

2. Login.

3. Wait 2.5 minutes to be sure the system has completed booting and is in a consistent starting state.
4. Double-click the AutoDealer.xls file to open it.

5. Wait 10 seconds after opening the file.

6. Prepare the stopwatch.

7. Simultaneously press F9 and start the stopwatch.

8. Stop the stopwatch when the Data Table indicator on the Status Bar goes away.

9. Record this time as the test’s result.

10. Repeat these steps four times for a total of five runs.

We report the time, in seconds, that Microsoft Office Excel 2007 took to perform the recalculation. Lower times
indicate faster performance and so are better.

Viewing data in Intuit QuickBooks Pro 2006

The application involved
¢ Intuit QuickBooks Pro 2006

The data file involved
e sample_product based business.QBB, a 7,036KB sample QuickBooks data file

The test process
First, prepare each system by following these steps once to load the test QuickBooks database:

a. Launch Intuit QuickBooks Pro 2006.

b. Click File>Restore.

c. At the Restore Company Backup dialog box, select the radio button next to Disk:, if that button is not
already selected.

d. Click the Browse button.
e. Browse to the sample_product based business.QBB file, and click Open. This action returns you to
the Restore Company Backup dialog box.
f. Click Restore.
g. Click Yes to confirm overwriting an existing company file.
h. Type YES in the field in the Delete Entire File dialog box, and click OK.
i. Click OK at the two subsequent QuickBooks Information dialog boxes.
Principled Technologies, Inc.: System performance in predictive modeling and 15
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To execute the test, follow these instructions. You will need one stopwatch.

Reboot the system under test.

Log in.

Wait 2.5 minutes to be sure the system has completed booting and is in a consistent starting state.
Double-click the Intuit QuickBooks Pro 2006 desktop icon.

Click Open to open the company file (sample_product based business.gbw).

Click OK to close the QuickBooks information dialog.

At the Register Intuit QuickBooks Pro 2006 screen, click Remind Me Later.

Click Window—>Close All to close any open windows.

Select Favorite Reports from the drop-down list.

10. Prepare the stopwatch.

11. Simultaneously click Display and start the stopwatch.

12. Stop the stopwatch when all the report windows are open (pay particular attention to top left report).
13. Record this time as the test’s result.

14. Click Window—>Close All to close the reports before closing QuickBooks Pro to re-run the test.

15. Repeat these steps four times for a total of five runs.

©CoNooOA~LON =

We report the time, in seconds, that Intuit QuickBooks Pro 2006 took to load the reports. Lower times indicate
faster performance and so are better.

.‘ Principled Technologies, Inc.
Al 1007 Slater Road, Suite 250
Principled . Durham, NC 27703
ITechnoIogles www.principledtechnologies.com
info@principledtechnologies.com

Principled Technologies is a registered trademark of Principled Technologies, Inc.

Intel, the Intel Logo, Core, Pentium, and vPro are trademarks or registered trademarks of Intel Corporation or its
subsidiaries in the United States and other countries. All other product names are the trademarks of their
respective owners.

Disclaimer of Warranties; Limitation of Liability:

PRINCIPLED TECHNOLOGIES, INC. HAS MADE REASONABLE EFFORTS TO ENSURE THE ACCURACY AND VALIDITY OF ITS
TESTING, HOWEVER, PRINCIPLED TECHNOLOGIES, INC. SPECIFICALLY DISCLAIMS ANY WARRANTY, EXPRESSED OR
IMPLIED, RELATING TO THE TEST RESULTS AND ANALYSIS, THEIR ACCURACY, COMPLETENESS OR QUALITY, INCLUDING
ANY IMPLIED WARRANTY OF FITNESS FOR ANY PARTICULAR PURPOSE. ALL PERSONS OR ENTITIES RELYING ON THE
RESULTS OF ANY TESTING DO SO AT THEIR OWN RISK, AND AGREE THAT PRINCIPLED TECHNOLOGIES, INC., ITS
EMPLOYEES AND ITS SUBCONTRACTORS SHALL HAVE NO LIABILITY WHATSOEVER FROM ANY CLAIM OF LOSS OR DAMAGE
ON ACCOUNT OF ANY ALLEGED ERROR OR DEFECT IN ANY TESTING PROCEDURE OR RESULT.

IN NO EVENT SHALL PRINCIPLED TECHNOLOGIES, INC. BE LIABLE FOR INDIRECT, SPECIAL, INCIDENTAL, OR
CONSEQUENTIAL DAMAGES IN CONNECTION WITH ITS TESTING, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
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